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 Important Information

Warranty
The VXI-MXI-Express Series controllers are warranted against defects in materials and workmanship for a period of one year from the date 
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves 
to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no 
agency, partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
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 Compliance

Compliance with FCC/Canada Radio Frequency Interference 
Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.
Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.
All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.
Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 
Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.
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About This Manual

This manual contains instructions for installing and configuring the 
VXI-MXI-Express series controller interface kit. It also discusses how 
to start developing your VXI/VME application.

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on a 
product, refer to the Safety section in Appendix A, Specifications, for 
information about precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

VXI-MXI-Express This term implies any of the VXI-MXI-Express Series controllers, such as
Series controller the NI VXI-8360T.
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x1 MXI-Express This term implies any of the x1 MXI-Express host adapters, such as the
host adapter NI PCIe-8361, NI PCIe-8362, and NI ExpressCard-8360.

Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• Your computer and/or chassis documentation

• PCI Express Specification, Revision 1.0a

• NI ExpressCard MXI Series User Manual

• MXI-Express (x1) for PXI Express Series User Manual

• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile 
Backplane Bus: VMEbus

• ANSI/IEEE Standard 1155-1998, IEEE VMEbus Extensions for 
Instrumentation: VXIbus

• ANSI/VITA 1-1994, VME64

• VXI-6, VXIbus Mainframe Extender Specification, Rev. 2.0, VXIbus 
Consortium

• NI-VISA Help

• NI-VXI Help

• Measurement & Automation Explorer Help for NI-VISA/NI-VXI
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1
Introduction

This chapter describes your VXI-MXI-Express Series controller interface 
kit, lists what you need to get started, and includes a brief description of the 
hardware and software.

The VXI-MXI-Express Series controller interface kits link a 
PCI Express-based host computer to the VXIbus using the National 
Instruments MXI-Express (x1) interface. These kits make your computer 
perform as though it were plugged directly into the VXI backplane, giving 
it the capabilities of an embedded computer.

The National Instruments VXI-MXI-Express Series controllers include the 
NI VXI-8360T and any kit containing the NI VXI-8360T. The controllers 
are C-sized VXI modules which plug into your VXI mainframe. The 
VXI-8360T incorporates functionality allowing the extension of the 8 TTL 
backplane triggers and CLK10 between multiple chassis through 
convenient front panel connectors.

Several different MXI-Express (x1) interfaces are available with the 
VXI-MXI-Express Series controller.

• NI PCIe-8361 is a single port (x1) PCI Express to MXI-Express 
interface board. This board plugs into an available PCI Express slot 
in the host computer.

• NI PCIe-8362 is a two port (x1) PCI Express to MXI-Express interface 
board. This board plugs into an available PCI Express slot in the host 
computer.

• NI ExpressCard-8360 is a (x1) ExpressCard/34 MXI-Express interface 
module that will work in both an ExpressCard/34 and ExpressCard/54 
slot. With the ExpressCard interface, hybrid VXI systems can be built 
using National Instruments PXI and PXIe-based host computers. The 
NI ExpressCard-8360 can also be used to bring mobile/laptop control 
to the VXI system.

Kits that include a MXI-Express interface board also include a 3 m (x1) 
MXI-Express cable. 1 m and 7 m cables are also available and can be 
purchased separately.
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The kits also include the NI-VXI/NI-VISA bus interface software, which 
is fully VXIplug&play-compliant. NI-VXI/NI-VISA is the National 
Instruments implementation of the VISA I/O software standard on which 
all VXIplug&play software components are based.

What You Need to Get Started
To set up and use the VXI-MXI-Express Series controller interface kit, you 
need the following items:

❑ A host computer with an available PCI Express slot1 running the 
Windows XP operating system

❑ A PCI Express or ExpressCard to MXI-Express interface card

❑ A VXIbus mainframe

❑ A VXI-MXI-Express Series controller

❑ A x1 MXI-Express cable

❑ The National Instruments NI-VXI driver software CD

❑ This manual

Hardware Description
The VXI-MXI-Express Series controller is a C-size VXIbus Slot 0-capable 
device that can reside in slot 0 of any C-size or D-size chassis.

Note D-size VXI mainframes have connections for a P3 connector. The 
VXI-MXI-Express Series controller, however, does not have this connector 
and cannot provide the necessary control for VXI devices that need P3 support.

1   Some x16 slots may not work correctly with MXI-Express adapters.
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VXI-MXI-Express Front Panel Features
The VXI-MXI-Express Series controller has the following front panel 
features:

• Eight front panel LEDs

– FAILED—Indicates the VXI-MXI-Express Series controller 
failed power on diagnostics.

– SYSFAIL—Indicates the VMEbus SYSFAIL line has been 
asserted on the backplane.

– ONLINE —Indicates the board is detected and ready for use.

– ACCESS—Indicates a VXI bus master is accessing the 
VXI-MXI-Express Series controller.

– CB—Indicates the circuit breaker has tripped from an over current 
condition on the +5.0 VDC rail of the VXI-MXI-Express Series 
controller.

– ACT—Indicates bus activity on the MXI-Express link.

– PWRGD—Indicates the on board power supplies are in 
regulation.

– LINK—Indicates the MXI-Express link connecting the host 
computer to the VXI-MXI-Express Series controller has been 
established.

• Three front panel SMB connectors for:

– Trigger input

– Trigger output

– CLK10 I/O

• One x1 MXI-Express connector

• TRIG/CLK PORT A(B)—These ports allow the user to daisy chain 
the eight TTL backplane triggers and/or CLK10 between multiple 
chassis.

• CABLE STATUS LED

Off Indicates no cables are connected to the TRIG/CLK 
PORT A(B) ports.

Blinking Red Indicates the cables are connected incorrectly to the 
TRIG/CLK PORT A(B) ports.

Solid Green Indicates the cables are connected correctly to the 
TRIG/CLK PORT A(B) ports.
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Advanced Configuration Options
The VXI-MXI-Express default hardware configuration should be 
acceptable for most systems. Refer to Appendix B, Default Settings, only 
if your system uses the front-panel CLK10 and trigger SMB connectors.

The NI-VISA/NI-VXI bus interface software includes a Resource 
Manager, an interactive configuration and troubleshooting program, 
a comprehensive library of software routines for VXI/VME programming, 
a logging utility you can use for debugging, and graphical interactive 
control programs for interacting with VISA. You can use this software to 
seamlessly program multiple-mainframe configurations and have software 
compatibility across a variety of controller platforms.

NI-VISA has a comprehensive library of software routines not only for 
VXI/VME programming, but also for GPIB, GPIB-VXI, PXI, TCP/IP, and 
Serial. You can use this software to program instruments connected through 
different types of interfaces.

Measurement & Automation Explorer (MAX) helps you view your 
entire test and measurement system and configure various components, 
whether they are VXI, GPIB, PXI, or Serial devices. You can easily 
add VME devices to your system with MAX and view them in the 
configuration tree along with the rest of your system. MAX features various 
options for running the Resource Manager, Resman, such as performing 
resource manager operations on your VXI systems and configuring Resman 
to run automatically at startup. You also can execute Resman independently 
to configure your instruments after each power cycle.

The NI Spy utility tracks the calls your application makes to National 
Instruments drivers, including NI-VXI, NI-VISA, and NI-488.2. NI Spy 
helps you debug your application by clearly highlighting the functions that 
return errors. You can let NI Spy keep a log of your program’s calls to these 
drivers so that you can check them for errors at your convenience.

National Instruments Application Software
In addition to the NI-VISA/NI-VXI software, you can use the National 
Instruments LabVIEW, Measurement Studio, and LabWindows™/CVI™ 
application programs and instrument drivers to ease your programming 
task. These standardized programs match the modular virtual instrument 
capability of VXI and can reduce your VXI/VME software development 
time. These programs are fully VXIplug&play compliant and feature 
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extensive libraries of VXI instrument drivers written to take full 
advantage of direct VXI control. LabVIEW, Measurement Studio, and 
LabWindows/CVI include all the tools needed for instrument control, data 
acquisition, analysis, and presentation.

LabVIEW is an easy-to-use, graphical programming environment you can 
use to acquire data from thousands of different instruments, including 
IEEE 488.2 devices, VXI devices, serial devices, PLCs, and plug-in data 
acquisition boards. After you have acquired raw data, you can convert 
it into meaningful results using the powerful data analysis routines in 
LabVIEW. LabVIEW also comes with hundreds of instrument drivers, 
which dramatically reduce software development time, because you do not 
need to spend time programming the low-level control of each instrument.

Measurement Studio allows you to choose from standard environments 
such as Microsoft Visual Basic, Visual C++, and Visual Studio .NET to 
create your application, using tools specific for each language. With 
Measurement Studio, you can write programs quickly and easily and 
modify them as your needs change.

LabWindows/CVI is an interactive ANSI C programming environment 
designed for building virtual instrument applications. LabWindows/CVI 
delivers a drag-and-drop editor for building user interfaces, a complete 
ANSI C environment for building your test program logic, and a collection 
of automated code generation tools, as well as utilities for building 
automated test systems, monitoring applications, or laboratory 
experiments. 

To use any of these application programs, install them before installing 
the NI-VISA/NI-VXI software. LabVIEW, Measurement Studio, and 
LabWindows/CVI integrate the VXI and VISA libraries required to support 
your VXI-MXI-Express. You also get hundreds of complete instrument 
drivers, which are modular, source-code programs that handle the 
communication with your instrument to speed your application 
development.
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2
Installation and Configuration

This chapter explains how to set up your test system.

Installing the Software
Use the Setup program that came with your NI-VXI/NI-VISA software to 
install the entire software package or a software update, or to reinstall 
software in the event that your files were accidentally erased. Some of the 
utilities rely on the LabWindows/CVI Run-Time Engine. This software is 
installed, if necessary, during the NI-VXI/NI-VISA installation.

Depending on the type of installation you choose, you may need up to 
500 MB of free space on your hard drive to accommodate the NI-VXI and 
NI-VISA software.

To be compliant with VXIplug&play specifications, a VXI controller must 
provide the VISA I/O driver library standardized by VXIplug&play. VISA 
ensures that your controller can run all VXIplug&play-compatible software 
now and in the future.

The NI-VISA software in this kit is compatible with the WINNT/GWINNT 
framework. With NI-VISA installed on your computer, you can run any 
VXIplug&play software that is compatible with this framework. This 
includes instrument drivers and executable soft front panel software 
included with VXIplug&play-compatible instruments from a variety 
of vendors.

Installing the NI-VXI and NI-VISA Software
This section describes how to install the NI-VXI and NI-VISA software.

Carefully read these directions along with any messages on the screen 
before making your selections. You can quit the Setup program at any time 
by clicking the Cancel button.
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Caution To keep the manufacturer/model name tables or the VME device configuration 
from a previous installation, be sure to back them up before starting Setup. They are in the 
TBL subdirectory of your NI-VXI directory, usually Program Files\National 
Instruments\VXI.

Setup is an interactive, self-guiding program that installs the NI-VXI and 
NI-VISA software and configures your system to use the software with 
the VXI-MXI-Express. Complete the following steps to perform the 
installation.

1. Insert the CD. When prompted, select Install NI-VXI from the menu.

If no menu appears when the CD is inserted:

a. Select Start»Run and enter the following text, where X is your 
CD drive (usually D):

X:\setup.exe

b. Click the OK button to begin installing NI-VXI.

2. Click the Next button at the Welcome screen to start the installation 
and accept the license agreement.

Note If you have a previous version of the NI-VXI software installed, Setup installs the 
new version over the previous version.

3. Select the installation features from the Features screen.

• For more information about the NI-VXI API, refer to Chapter 3, 
Developing Your Application.

4. Click the Next button. After reading the license agreement(s), confirm 
your acceptance.

5. Click the Next button. Confirm that you are ready to install and click 
Next again to begin the installation.

6. Setup now copies the necessary files to your hard drive and creates 
program icons.

Completing the Software Installation
Review the information in any README files that Setup prompts you 
to read.

When the installation process completes, reboot the system for the changes 
to take effect. If you backed up the manufacturer and model name files, 
restore them to the TBL subdirectory of your NI-VXI directory before 
running MAX.
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Note If you save and restore the TBL files from an older version of NI-VXI, the software 
will use TBL files that do not have the latest updates from National Instruments and may 
not include recent hardware releases. If you added additional manufacturer or model names 
to your TBL files, we recommend merging those changes with the latest updates included 
with this version of NI-VXI, so that all your devices are properly identified.

Configuring the Hardware (Optional)
This section contains basic information about configuring your 
VXI-MXI-Express Series controller hardware. Because the default settings 
for your VXI-MXI-Express Series controller hardware are acceptable for 
most typical applications, this section is optional.

Refer to Appendix B, Default Settings, for a complete listing of the 
hardware and software default settings.

Use Measurement & Automation Explorer (MAX) to change any 
VXI-MXI-Express Series controller configuration settings. 

For information about the software, including optional settings, use MAX 
and its online help. Use the Windows Start menu to open the program group 
for National Instruments, launch MAX, and select Help»Help Topics.

Installing the Hardware
This section summarizes how to install your VXI-MXI-Express Series 
controller hardware.

Caution To guard against electrostatic discharge, touch the antistatic plastic packages to a 
metal part of your computer or chassis before removing the boards from their packages. 
Your computer or chassis should be plugged in but powered off.

Installing Your VXI-MXI-Express Series Controller

Note Although the VXI-MXI-Express Series controllers are typically installed in Slot 0 
of the VXI chassis, they may operate in other slots of the chassis. If you choose to install 
the controller in a slot other than Slot 0, the automatic detection circuitry on the controller 
will detect the slot and configure the controller appropriately, if the J2 jumper is set to 
Auto-detect.
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Cautions Having more than one device configured as system controller can damage the 
VXI system. For VXI systems that include VME devices, ensure that the VME devices are 
not configured in the upper 16 KB (starting from 0xC000) of the A16 address space. This 
region is reserved for VXI device configuration registers, which are used for initializing, 
configuring, and interacting with VXI devices. The VXI-MXI-Express Series controller 
also uses this region for this purpose.

Also ensure that no other VXI devices in your system are manually configured for the same 
logical address as your controller. The default shipping configuration is that the card 
auto-detects if it is in Slot 0.

To install the VXI-MXI-Express Series controller in Slot 0 of your VXI 
chassis, complete the following steps.

1. Power off the chassis.

2. Verify that the backplane connector is intact and that there are no bent 
or missing pins on the controller.

3. Insert the VXI-MXI-Express Series controller into the chassis in 
Slot 0, as shown in Figure 2-2.

4. Firmly press the VXI-MXI-Express Series controller into the mating 
connectors to ensure the module is fully inserted and seated in the 
connector.

5. Tighten the two ejector handle screws.

6. Power on the chassis.

The VXI system controllers operate certain VXI lines as required for 
VXI systems. Verify that any other VXI devices with system controller 
capability that are in the same chassis are not configured as system 
controller.
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Installing Your NI PCIe-8361/NI PCIe-8362 x1 PCI Express to 
MXI-Express Interface Card

To install your NI PCIe-8361/NI PCIe-8362 x1 PCI Express to 
MXI-Express module, complete the following steps.

1. Power off your computer, but leave it plugged in while installing the 
NI PCIe-8361/NI PCIe-8362. The power cord grounds the chassis and 
protects it from electrical damage while you install the card.

Caution To protect both yourself and the computer from electrical hazards, your computer 
should remain off until you finish installing the NI PCIe-8361/NI PCIe-8362.

2. Open the host computer or remove the top cover to gain access to the 
host computer PCIe expansion slots.

3. Select any available PCI Express expansion slot.

Note The BIOS or motherboard may not support the NI PCIe-8361/NI PCIe-8362 in a slot 
intended for a graphics card.

4. Locate the slot. Remove any slot and back panel covers and hardware 
(for example, screws).

5. Touch the metal part of the power supply case inside the computer to 
discharge any static electricity that might be on your clothes or body.

6. Line up the NI PCIe-8361/NI PCIe-8362 with the slot on the 
back panel. Slowly push down on the top of the NI PCIe-8361/
NI PCIe-8362 until its card-edge connector is resting on the expansion 
slot receptacle. Using slow, evenly distributed pressure, press the 
NI PCIe-8361/NI PCIe-8362 straight down until it seats completely in 
the expansion slot, as shown in Figure 2-1.

7. Reinstall the bracket-retaining mechanism to secure the 
NI PCIe-8361/NI PCIe-8362 to the back panel rail.

8. Replace the computer cover.
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Figure 2-1.  Installing the NI PCIe-8361/NI PCIe-8362

Installing Your NI ExpressCard-8360 ExpressCard MXI Interface
Complete the following steps to install the ExpressCard interface card.

1. Power off your computer.

Note You may want to connect one end of the x1 MXI-Express cable to the 
ExpressCard-8360 prior to installing it into the host computer.

2. Insert the ExpressCard-8360 in any available ExpressCard/34 or 
ExpressCard/54 slot.

Connecting Cables
Connect the x1 MXI-Express cable to the VXI-MXI-Express Series 
controller and then to the x1 MXI-Express host adapter in the host 
computer.

1 NI PCIe-8361/NI PCIe-8362 Card
2 PCI Express Card Edge Connector

3 PCI Express Slot

1
3

2
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Figure 2-2 shows a system that includes a PCI Express-based host 
computer and a VXI-MXI-Express Series controller.

Figure 2-2.  Host System with VXI-MXI-Express Series Controller

For information on connecting cables to TRIG/CLK PORT A(B) on the 
NI VXI-8360T, refer to the Connecting the Trigger Port Cables section of 
Appendix D, Using The Trigger Ports On The VXI-8360T.

Powering Up the MXI-Express System
Complete the following steps to power up the system.

Note All VXI expansion chassis must be fully powered before turning on the host 
computer, otherwise the expansion chassis will not be detected by the host.

There are no requirements on how VXI-MXI-Express-based expansion chassis are 
powered up relative to each other as long as they are all on before the host computer 
is powered on.

1 Host Computer
2 VXI Mainframe

3 VXI-MXI-Express Series Controller in Slot 0
4 Host Cable

bus

  NATIONAL

INSTRUMENTS
®

1

4

3

2
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1. Power on all of the VXI expansion chassis in any order you choose.

2. Power on the host computer.

Powering Down the MXI-Express System
Because operating systems and drivers commonly make the assumption 
that PCI devices will be present in the system from power-up to 
power-down, it is important not to power off the expansion chassis until 
after the host PC is powered off. Powering off the expansion chassis while 
the host is still on can cause crashes or hangs. The order in which expansion 
chassis are powered off, relative to each other, is not important.

Software Configuration and Verification
Complete the following steps to configure the software and verify the 
configuration.

1. Run MAX. You must run the Resource Manager (Resman) every time 
the chassis or computer power is cycled, so that your application can 
access devices in the VXI chassis. You can also configure MAX to run 
Resman automatically at every computer startup by selecting Tools»
NI-VXI»VXI Options from the menu and selecting the appropriate 
checkbox.

2. You can also use MAX to interactively configure the National 
Instruments hardware in your system. Use the right-click help for 
information about the various configuration options. After you finish 
configuring the system through MAX, verify the configuration 
through the interactive control utility, VISAIC (Start»Programs» 
National Instruments»VISA»VISA Interactive Control), as 
described in Chapter 3, Developing Your Application.

Note If you are using extenders such as MXI-2 to create a multichassis system, you may 
need to run Resman before configuring some of your devices.
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3
Developing Your Application

This chapter discusses the software utilities you can use to start developing 
applications that use NI-VXI.

After installing the NI-VXI software, you can begin developing your 
VXI/VME application. Be sure to check the release notes for the latest 
application development notes and changes.

NI-VXI, NI-VISA, and Related Terms
Before you develop your application, it is important to understand the 
difference between NI-VXI, NI-VISA, and similar terms.

• NI-VXI is the software package that ships with National Instruments 
VXI and VME controllers. NI-VXI includes Measurement & 
Automation Explorer (MAX), NI-VISA, NI Spy, Resource Manager 
(Resman), VXI device drivers, and other utilities for configuring and 
controlling your VXI or VME system.

• NI-VISA is the native API for communicating with VXI/VME devices. 
NI-VISA is the National Instruments implementation of the VISA I/O 
standard, which is a common interface to many types of instruments 
(such as VXI, GPIB, PXI, Serial, TCP/IP, and so on). NI-VXI is 
optimized for use through NI-VISA, and NI recommends using 
NI-VISA to develop all new VXI/VME applications.

• The NI-VXI API is an optional development environment that is 
not part of the default NI-VXI installation. The NI-VXI API was 
developed before NI-VISA; although NI-VXI still supports the 
NI-VXI API, NI recommends using NI-VISA for all new VXI/VME 
applications. If you must develop an application using the older 
NI-VXI API, run the NI-VXI installer and enable NI-VXI API 
Development. Be sure to review the NI-VXI API Notes section.

• The NI-VXI compatibility layer allows older programs that use the 
NI-VXI API to communicate with VXI devices through VISA. Using 
this compatibility layer, older programs can run in NI-VXI 3.0 or later 
without being rewritten to use the VISA interface. This layer installs 
with NI-VXI by default. It should be completely transparent and 
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provide a high level of performance; however, there may be some 
slight changes in behavior for certain applications.

Your software features several system development utilities including 
MAX, Resman, NI Spy, VISA Interactive Control (VISAIC), and 
optionally VXI Interactive Control (VIC). You can also access online 
help and a variety of examples to learn how to use NI-VXI for certain 
tasks. Each component assists you with one of four development steps: 
configuration, device interaction, programming, and debugging.

You can access the utilities, help files, and release notes through the 
Windows Start menu by opening the National Instruments»VXI or 
National Instruments»VISA program groups.

Configuration
The configuration utilities in your software kit are Resource Manager 
(Resman) and Measurement & Automation Explorer (MAX). Resman 
performs VXI Resource Manager functions as described in the VXIbus 
specification. Resman configures all devices on the VXI backplane for 
operation and allocates memory for devices that request it. Resman does 
not require you to specify any settings; it automatically performs the VXI 
resource management whenever you run it.

Note Power cycling resets all devices, so you must run Resman to reconfigure your 
system every time you cycle the power on the chassis.

MAX presents a graphical display of your entire test and measurement 
system to help you configure various components. When you launch MAX, 
you see all your devices (including VXI) on the screen. You can view the 
properties (such as logical address and address space) of each device by 
clicking the device in the configuration tree. To see additional configuration 
options for a given device, right-click the device in the configuration tree. 
When you access the properties of most National Instruments devices 
by right-clicking, you can configure the hardware settings by selecting 
Hardware Configuration.

MAX and Resman are designed to work together. You can run Resman 
through MAX by either clicking the Run VXI Resource Manager button in 
the toolbar or right-clicking a specific VXI system on which to run Resman, 
as shown in Figure 3-1. You can also select Tools»NI-VXI»VXI Resource 
Manager to run Resman on all VXI systems. From the VXI Options dialog 
box in the Tools»NI-VXI menu, you can also use MAX to configure 
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Resman to run on all VXI systems automatically when the computer boots. 
Resman reports to MAX all errors it finds in your system. When you view 
your VXI system in MAX, you can easily spot any errors that Resman 
found while configuring the system.

Figure 3-1.  Right-Click a VXI System in MAX to Run Resman on that System

After Resman detects and configures all your VXI/VME devices, you can 
use MAX to view specific information about each device in your system. 
The default MAX view of a VXI system shows the General tab window, 
which contains a summary of key information about each device, including 
its device name, logical address, model name, and other data. For more 
information about MAX, refer to its online help by selecting the 
Help»Help Topics menu.

Device Interaction
You can interact with your VXI/VME devices using the VISA Interactive 
Control (VISAIC) utility. VISAIC allows you to control your VXI/VME 
devices without using LabVIEW, Measurement Studio, LabWindows/CVI, 
or another programming language. You can also control your devices in 
MAX by right-clicking a device name and selecting Open VISA Session. 
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Note You can also use VXI Interactive Control Program (VIC) to control your VXI/VME 
devices and develop and debug VXI application programs. VIC is not included in the 
default NI-VXI installation. To install VIC, select NI-VXI API Development in the 
installer. You can launch VISAIC (or VIC) from the Tools menu in MAX or from the 
VISA or VXI subgroups in Start»Programs»National Instruments.

Try the following in VISAIC: In the tree view, navigate using your mouse 
to the VISA resource for your controller—probably VXI0::0::INSTR, 
representing the VXI system 0, logical address 0 instrument resource, 
as shown in Figure 3-2.

Figure 3-2.  Select Your Controller in VISAIC

Open the selected resource and navigate to the Register I/O tab (Show all 
VISA operations must be turned on for this to be visible). In this tab, you 
can read registers on your device, such as the VXI device configuration 
registers. Execute the viIn operation (called In in LabVIEW compatibility 
mode) with the default parameters. The Data Value field shows the I/O 
operation result, such as 0x9ff6. The Return Value field shows the 
function status, such as 0 for VI_SUCCESS, as shown in Figure 3-3.
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Figure 3-3.  Successful viIn Access in the VISAIC Register I/O Tab 
(This Window May Look Slightly Different for LabVIEW Users)

If the data value ends in FF6, you have successfully read the National 
Instruments manufacturer ID from your VXI/VME controller’s ID register. 
You may now want to read the configuration registers from other VXI 
devices in your system by opening the devices in VISAIC. Try reading a 
register from each device listed in the MAX view of your VXI system. This 
way, you can verify that your VXI controller can access each device in your 
VXI system successfully. You can also access VXI and VME devices 
configured in A16, A24, or A32 space by opening the VXI MEMACC 
resource, which is VISA’s representation of VXI memory. For more 
information about VISAIC operations and commands, refer to the online 
help in the Help menu and the context-sensitive help (such as What’s 
This?), available by right-clicking in any panel. You also can right-click 
over items in panels for details on their purpose.
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Programming for VXI
NI-VISA and the NI-VXI API are the two National Instruments 
programming interfaces for accessing your VXI/VME instruments. With 
NI-VXI 3.0 or later, NI-VISA is the native API for communicating with a 
VXI or VME system, and NI recommends using it for all new applications. 
Older programs that use the NI-VXI API now use the NI-VXI-to-NI-VISA 
compatibility layer to communicate with the VXI devices. Using this layer, 
older programs can run in NI-VXI 3.0 or later without being rewritten to 
use the VISA interface.

Note The NI-VXI API development environment is not installed by default as part of 
the NI-VXI installation. NI recommends using NI-VISA rather than NI-VXI for all new 
VXI/VME applications. If you must develop an application using the older NI-VXI API, 
run the NI-VXI installer and select the NI-VXI API Development option in the Feature 
Selection screen. Be sure to review the NI-VXI API Notes section of this manual.

NI-VISA is the National Instruments implementation of the VISA API as 
the VXIplug&play standard defines. It provides a common interface to 
many types of instruments (such as VXI, GPIB, PXI, Serial, TCP/IP, and 
so on) and therefore is especially useful in situations where you are using 
multiple types of instruments.

Both NI-VISA and the NI-VXI API include functions for register-level 
access to VXI instruments and messaging capability to message-based 
devices. You can also use either interface to service asynchronous events 
such as triggers, signals, and interrupts, and also assert them. Compatibility 
with the NI-VXI API is included for legacy applications only—
NI recommends that you write all new VXI/VME applications in VISA.

The best way to learn NI-VISA programming is by reviewing the example 
programs your software includes. The examples directory contains working 
VISA programs that illustrate many different types of applications. You can 
find these examples in the Windows Start menu under Programs»
National Instruments»VISA»Examples.

If you are just getting started, you should learn how to access registers 
with high-level calls and send messages with word-serial functions. The 
NI-VISA examples for these tasks are HighReg.c and RdWrt.c. Refer 
to the other examples as you try more advanced techniques. Consult the 
NI-VISA online help for additional information about these topics.
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Table 3-1 summarizes the topics the example programs address. All 
files are found through the Windows Start menu under Programs»
National Instruments»VISA»Examples, in the subdirectories listed 
below.

Note MAX includes configuration options that affect low-level functions and shared 
memory, as well as trigger mappings and other attributes of your VXI system. Refer to 
the MAX online help for information regarding these options.

Optimizing Large VXIbus Transfers
For best performance, keep the following in mind when using viMove() 
or VXImove():

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Use VXI block access privileges to significantly improve performance 
to devices that can accept block transfers, and likewise use D64 access 
privileges for devices that can accept the VME64 64-bit data transfer 
protocol.

• To optimize move performance on virtual memory systems such as the 
Windows operating system, lock the user buffer in memory yourself so 
the move operation does not need to lock the buffer.

• To optimize move performance on paged memory systems such as 
the Windows operating system, use a contiguous buffer so the move 
operation does not need to build a scatter-gather list for the user buffer.

Note viMemAlloc() or VXImemAlloc() returns 32-bit aligned, page-locked, 
continuous buffers that work efficiently with the move operations.

Table 3-1.  NI-VISA/NI-VXI Examples

Coverage NI-VISA Example

NI-VXI 
Example 

(Optional)

Message-Based Access C\General\RdWrt.c VXIws.c

High-Level Register Access C\VXI-VME\HighReg.c VXIhigh.c

Low-Level Register Access C\VXI-VME\LowReg.c VXIlow.c

Interrupt Handling C\VXI-VME\AsyncIntr.c and WaitIntr.c VXIint.c

Trigger Handling C\VXI-VME\WaitTrig.c VXItrig.c
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NI-VXI API Notes
The following notes apply only if you are using the NI-VXI API. 
National Instruments recommends that all new VXI/VME applications use 
the NI-VISA API, but you can still develop with the older NI-VXI API for 
compatibility with legacy code.

Compiler Symbols
You may need to define certain compiler symbols so that the NI-VXI 
library can work properly with your program. The required symbol 
indicates your operating system platform; for example, VXINT designates 
the application as a Windows 2000/NT/XP/Me/98 application.

Note LabWindows/CVI automatically defines the correct symbol. You do not need to 
define VXINT when using LabWindows/CVI.

The additional symbol BINARY_COMPATIBLE is optional. It ensures 
that the resulting application is binary compatible with other National 
Instruments VXI controllers using the same operating system. This symbol 
may cause a slight performance degradation when you use low-level 
VXIbus access functions on some controllers.

You can define these symbols using #define statements in your source 
code or using the appropriate option in your compiler (typically either –D 
or /D). If you use #define statements, they must appear in your code 
before the line that includes the NI-VXI API header nivxi.h.

Compatibility Layer Options
Although NI-VXI supports multiple VXI controllers through NI-VISA, the 
NI-VXI API supports only a single controller. To specify which controller 
the emulation layer should use, run MAX. Select Tools»NI-VXI»VXI 
Options. Select the VXI system that will support the emulation layer.

In NI-VXI 3.0 or later, when you enable for triggers or interrupts, only 
the local controller is enabled. In the NI-VXI API functions for enabling 
triggers and interrupts, the controller parameter is ignored. If you need 
to enable a remote controller for triggers, use the MAX frame resource to 
map the trigger back to the local controller. Refer to the NI-VISA Help for 
additional information.
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The interrupt and trigger routing in the NI-VXI 3.0 or later low-level 
drivers is somewhat different from the default routing in previous versions 
of NI-VXI. Therefore, the compatibility layer may behave differently than 
the original NI-VXI API with regard to these settings. In particular, if you 
are receiving triggers on an external controller, you may need to modify the 
trigger configuration on your extender module using MAX. Consult the 
manual for your extender module for details. In general, interrupts are 
routed automatically based on the interrupt configuration the resource 
manager detects. Whether the changed routing behavior affects your 
program is application dependent.

Because VISA is an instrument-centric API, certain functions from the 
more controller-centric NI-VXI API do not match perfectly with a VISA 
counterpart. When an application enables an event with the NI-VXI API 
compatibility layer, each logical address is enabled for that event 
separately. For example, if the application enables an interrupt level, VISA 
will enable the interrupt on each logical address, one at a time, until all the 
devices are enabled. This means that some interrupts could be lost from 
devices with higher numbered logical addresses. MAX provides an 
option for users to pick which logical address is enabled first. Select 
Tools»NI-VXI»VXI Options. Set Prioritized Signal LA to the logical 
address of the device that generates the events. This prevents possible loss 
of events from that device.

Debugging
NI Spy and VISAIC are useful utilities for identifying the causes of 
problems in your application, and are installed by default with your NI-VXI 
installation.

NI Spy tracks the calls your application makes to National Instruments 
programming interfaces, including NI-VISA, NI-VXI, and NI-488. NI Spy 
highlights functions that return errors, so during development you can 
quickly spot which functions failed during a program’s execution. NI Spy 
can log the calls your program makes to these drivers so you can check 
them for errors at your convenience, or use the NI Spy log as a reference 
when discussing the problem with National Instruments technical 
support. Figure 3-4 shows an example of an error returned from a 
call to viMemAlloc.
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Figure 3-4.  NI Spy

VISAIC, as shown in Figure 3-5, is an excellent platform for quickly 
testing instruments and learning how to communicate with them. This 
utility is further discussed in the Device Interaction section of this chapter.

Figure 3-5.  VISAIC
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A
Specifications

This appendix lists the specifications for the VXI-MXI-Express Series 
controller.

Power Requirement

EXT CLK
Output Drive .......................................... 50 Ω source terminated ±24 mA 

output driver

VOL ......................................................... <800 mV

VOH......................................................... >2.0 V

Input Buffer............................................ TTL compatible input buffer

TRIG IN
Input Buffer............................................ TTL compatible input buffer

Voltage

Current

Typical (DC) Dynamic

+5 V 1.600 A 1.600 A

+12 V 0.020 A 0.020 A

–5.2 V 0.177 A 0.125 A

–2 V 0.060 A 0.125 A
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TRIG OUT
Output Drive ...........................................50 Ω source terminated ±40 mA 

output driver

VOL..........................................................<800 mV

VOH .........................................................>2.0 V

Physical
Size .........................................................C size, C-1

Dimensions ............................................. 23.3 × 43.0 cm (9.2 × 13.4 in.)

Weight ....................................................1.292 kg (45.6 oz)

I/O connectors

SMB.................................................3

Slot requirements ....................................Single VXI C-size slot

Compatibility ..........................................Fully compatible with VXI 
specification

VXI keying class ....................................Class 1 TTL

MTBF .....................................................Contact factory

Environmental
Maximum altitude...................................2,000 m

Pollution Degree .....................................2

Indoor use only.
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Operating Environment
Ambient temperature range.................... 0 to 55 °C (Tested in accordance 

with IEC-60068-2-1 and 
IEC-60068-2-2: meets 
MIL-PRF-28800F Class 3 low 
temperature limit and 
MIL-PRF-28800F Class 2 high 
temperature limit.)

Relative humidity range ......................... 10% to 90% (Tested in 
accordance with 
IEC-60068-2-56.)

Storage Environment
Ambient temperature range.................... –40 to 85 °C (Tested in 

accordance with IEC-60068-2-1 
and IEC-60068-2-2; meets 
MIL-PRF-28800F Class 3 limits.)

Relative humidity range ......................... 5% to 95% (Tested in accordance 
with IEC-60068-2-56.)

EMI ........................................................ FCC Class A verified, EC verified

Shock and Vibration
Operational shock .................................. 30 g peak, half-sine, 11 ms pulse 

(Tested in accordance with 
IEC-60068-2-27; meets 
MIL-PRF-28800F Class 2 limits.)

Random vibration

Operating ........................................ 5 to 500 Hz, 0.3 grms

Nonoperating .................................. 5 to 500 Hz, 2.4 grms 
(Tested in accordance with 
IEC-60068-2-64. Nonoperating 
test profile exceeds the 
requirements of 
MIL-PRF-28800F, Class 3.)
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Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, 
and laboratory use:

• IEC 61010-1, EN-61010-1

• UL 61010-1, CSA 61010-1

Note For UL and other safety certifications, refer to the product label or visit ni.com/
certification, search by model number or product line, and click the appropriate link 
in the Certification column.

Electromagnetic Compatibility
This product is designed to meet the requirements of the following 
standards of EMC for electrical equipment for measurement, control, 
and laboratory use:

• EN 61326 EMC requirements; Minimum Immunity

• EN 55011 Emissions; Group 1, Class A

• CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device according to product documentation.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit ni.com/
certification, search by model number or product line, and click the appropriate link 
in the Certification column.
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Environmental Management
National Instruments is committed to designing and manufacturing 
products in an environmentally responsible manner. NI recognizes that 
eliminating certain hazardous substances from our products is beneficial 
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the 
Environment Web page at ni.com/environment. This page contains the 
environmental regulations and directives with which NI complies, as well 
as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling 
center. For more information about WEEE recycling centers and National Instruments 
WEEE initiatives, visit ni.com/environment/weee.htm.

Cleaning
If you need to clean the module, use a soft, nonmetallic brush. Make sure 
that the module is completely dry and free from contaminants before 
returning it to service.

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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B
Default Settings

This appendix summarizes the default settings for the hardware and 
software in the VXI-MXI-Express kit. If you need more information 
about a particular setting or want to try a different configuration, refer 
to Appendix C, Advanced Hardware Configuration Settings, for your 
hardware reference and to the MAX online help for your software 
reference.

Default Hardware Settings
Figure B-1 and Table B-1 show the factory-default settings of the 
user-configurable jumpers on the VXI-MXI-Express Series controller. 
Tables B-2, B-3, B-4, B-5, and B-6 show user-configurable settings 
in Measurement & Automation Explorer (MAX).
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Figure B-1.  VXI-MXI-Express Shipping Configuration Settings

W7—TRIG CARD CLK10 DIR
1-2—OUT
2-3—IN

W2—SMB CLK10 DIR
1-2—IN (DFLT)
2-3—OUT

W3—EXT. SOURCE SELECT
1-2—SMB (DFLT)
2-3—TRIGGER CARD

W4—CLK10 SOURCE SELECT
1-2—INTERNAL OSC (DFLT)
2-3—EXTERNAL SOURCE

W5—MITE CONFIG
1-2—FACTORY
2-3—USER (DFLT)

W8

W8—MITE SELF CONFIG
1-2—DISABLE
2-3—ENABLE (DFLT)

1 2 3

J2—SLOT 0 DETECT
1-2—NON-SLOT 0
3-4—AUTO DETECT (DFLT)
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Default Software Settings
The following hardware configurations are available through 
Measurement & Automation Explorer (MAX).

Table B-1.  VXI-MXI-Express Series Controller Hardware Default Settings

Jumper Description Setting

W2 SMB CLK10 DIR 1–2 In (Default)
2–3 Out

W3 External CLK10 Source Select 1–2 SMB (Default)
2–3 Trigger Card

W4 CLK10 Source Select 1–2 Internal Osc. (Default)
2–3 Exteranl Source

W5 MITE Configuration 1–2 Factory
2–3 User (Default)

W7 Trigger Card CLK10 Direction 1–2 Out
2–3 IN

W8 MITE Self Configuration 1–2 Disable
2–3 Enable (Default)

J2 Slot 0 Detect 1–2 Non-Slot 0
3–4 Auto Detect (Default)
5–6 Slot 0

Table B-2.  MAX Device Tab Default Settings

Editor Field Default Setting

Device class Message-based

Number of handlers 1

Table B-3.  MAX Shared Memory Tab Default Settings

Editor Field Default Setting

Don’t share memory

A24/A32 write posting Enabled
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Table B-4.  MAX VXI Bus Tab Default Settings

Editor Field Default Setting

Bus timeout value 500 μs

VXI retry generation Enabled

Automatic retries Enabled

VXI transfer limit 256

A24/A32 write posting Enabled

Requester mode Release on Request

Request level 3

Operate as fair requester Enabled

Bus arbitration mode Prioritized

Arbiter timeout Disabled

Table B-5.  MAX PCI Tab Default Settings

Editor Field Default Setting

Low-level register access
API support

Enabled

User window size 512 kKB

DMA setting Enable DMA on this controller

Table B-6.  MAX SMB Tab Default Settings

Editor Field Default Setting

CLK10 50 Ω termination Disabled

Invert CLK10 polarity Enabled

TRIG IN 50 Ω termination Disabled
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C
Advanced Hardware 
Configuration Settings

This appendix describes the alternate hardware configuration settings for 
the VXI-MXI-Express Series controller. The board is set at the factory 
for the most commonly used configuration. Use this appendix if you 
want to try a different hardware configuration or if you would like more 
information on a particular setting. This information is intended for more 
advanced users.

The following hardware configuration settings are user configurable.

• Slot 0 detection

• VXIbus CLK10 routing

• SMB Trigger I/O

• Backplane trigger I/O

For the configuration switch locations and default settings, see Figure B-1, 
VXI-MXI-Express Shipping Configuration Settings.

Note Do not attempt an alternate setting unless you are familiar with its purpose. 
In addition, do not reconfigure any switches or jumpers not described in this appendix 
unless directed by National Instruments support.

Slot 0 Detection
The VXI-MXI-Express Series controller is configured at the factory to 
automatically detect if it is installed in Slot 0 of a VXI mainframe. With 
automatic System Controller slot detection the VXI-MXI-Express Series 
controller can be installed in any VXIbus slot.

The VXI-MXI-Express Series controller can be manually configured for 
either System Controller or Non-System Controller operation by defeating 
the automatic detection circuitry. Use the three position jumper J2 as shown 
in Figure C-1 to select between automatic detection, System Controller, or 
Non-System Controller.
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Figure C-1.  Slot 0 Detection through the J2 Jumper

Caution Do not install a device configured as the System Controller in any slot other 
than Slot 0. When installing into a slot other than Slot 0, first reconfigure it as either a 
Non-System Controller or for automatic detection. Failing to do so may result in damage 
to the VXI-MXI-Express Series controller and/or the backplane.

When the VXI-MXI-Express Series controller installed in Slot 0 of a VXI 
system it becomes the VXIbus System Controller. As the System Controller 
the VXI-MXI-Express Series controller has VXIbus Data Transfer Arbiter 
circuitry that accepts bus requests on all four VXIbus request levels, 
prioritizes the requests, and grants the bus to the highest priority requester. 
As the VXIbus System Controller the VXI-MXI-Express Series controller 
also drives the 16 MHz VXIbus system clock via an onboard 16 MHz 
oscillator. As required by the specification, when installed in Slot 0, the 
VXI-MXI-Express Series controller drives CLK10, a differential ECL 
output, to the VXIbus backplane. When the system is not installed in Slot 0 
it will only receive the CLK10 signal.

MITE EEPROM

User/Factory Configuration
The EEPROM is divided into two halves—one half is factory configured 
and one half is user configurable. Use jumper W5 to control whether the 
VXI-MXI-Express Series controller boots off the factory-configured 
EEPROM settings or the user-modified settings. In its default setting, the 
VXI-MXI-Express Series controller boots off the user-configurable half.

This jumper is useful in the event that the user-configured half 
of the EEPROM becomes corrupted in such a way that the 
VXI-MXI-Express Series controller boots to an unusable state. By 
changing this jumper setting, you can boot to the factory configuration and 
get up and running again. Use the procedure as described in the How to Fix 
an Invalid EEPROM Configuration section of this manual.

c. Slot 0/
System

Controller

a. Non-Slot 0/
Non-System

Controller

b. Auto Detect
(Default)

1 3 5

2 4 6

J2

1 3 5

2 4 6

J2

1 3 5

2 4 6

J2
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Figure C-2 shows the configuration settings for EEPROM operation.

Figure C-2.  EEPROM Configuration

Power-On Self Configuration
The VXI-MXI-Express Series controller has an onboard EEPROM, which 
stores default register values for the VXI circuitry. These values are loaded 
when you power up the computer. The values read from the EEPROM 
program the PCI interface and the VXIbus registers so that the VXI 
interface is ready to respond to Resource Manager accesses within the 
required 5 seconds of SYSRST# deasserting.

You can disable this power-on self-configuration (POSC) circuit by 
changing switch W8. Although this makes the VXI circuitry unusable, 
it is sometimes helpful in debugging address and interrupt conflicts 
with add-in boards. In general, however, you should leave W8 in its 
factory-default setting. Figure C-3 shows the possible configurations 
for W8.

Figure C-3.  Power-on Self Configuration Status

How to Fix an Invalid EEPROM Configuration
Use MAX under Windows to edit the VXI-MXI-Express Series controller 
configuration. Some of these settings are stored in files that the NI-VXI 
software reads, while other settings are stored directly in the 
VXI-MXI-Express Series controller EEPROM.

Certain EEPROM configurations, including invalid configurations, can 
lock up your computer while it is booting. Generally, only the size and 

a. Boot from User
Configuration (Default)

b. Boot from Protected
Configuration

W5 W5

2
3

1
2
3

1

a. Enable (default) b. Disable

W8
2 31

W8
2 31
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location of the memory windows can cause the VXI-MXI-Express Series 
controller to lock up your system. For example, many PCI-based computers 
will not boot if a board in its system requests more memory space than the 
computer can allocate. If you encounter this situation, you should reduce 
the size of the VXI-MXI-Express Series controller user memory window. 
The EEPROM can become corrupted if the VXI-MXI-Express Series 
controller is shut down while it is updating the EEPROM.

If one of these situations occurs after you change the configuration, 
complete the following steps to reconfigure the VXI-MXI-Express 
Series controller.

1. Power off your computer.

Caution To protect both yourself and the mainframe from electrical hazards, 
the mainframe should remain off until you finish changing the settings on the 
VXI-MXI-Express Series controller.

2. Change jumper W5 to the position shown in Figure C-2b to restore the 
factory configuration.

3. Power on the computer. The computer should boot this time because 
the factory-default configuration is being used to initialize the 
VXI-MXI-Express Series controller.

4. Run your software configuration utility to re-adjust the 
VXI-MXI-Express Series controller configuration.

5. After saving the configuration, exit Windows and power off the 
computer.

6. Change jumper W5 to the default position, as shown in Figure C-2a.

7. Power on the computer. If the computer does not boot with this 
configuration, you will need to repeat these steps, modifying your 
configuration until a final configuration is reached.

VXIbus CLK10 Routing
When the VXI-MXI-Express Series controller is installed in Slot 0 of your 
mainframe, it supplies the VXIbus CLK10 signal. Three different sources 
for CLK10 are available with the VXI-8360T:

• The internal 10 MHz ±100 ppm CLK10 oscillator. This is the default 
CLK10 source.

• The front panel CLK10 SMB. When configured as an input the front 
panel SMB allows an external source to be used as the source for the 
VXIbus CLK10 signal.
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• The front panel TRIG/CLK PORT A(B). CLK10 can be routed into the 
VXI-8360T from another VXI-8360T through the TRIG/CLK PORT 
A(B) on the front panel. Onboard jumpers are used to set this 
configuration.

Front Panel SMB Direction Control

W2—SMB CLK10 Direction
This jumper allows you to configure the front panel SMB connector on the 
VXI-MXI-Express Series controller.

The default jumper position, shown in Figure C-4a, In, shuts off CLK10 to 
the front panel SMB connector. Use jumpers W4 and W3 to configure the 
front panel SMB as an input for CLK10. In non-Slot 0 operation the SMB 
cannot be configured as an input as only the Slot 0 controller is allowed to 
supply CLK10 to the VXI backplane.

Setting the W2 jumper to Out, as shown in Figure C-4b, routes the VXIbus 
CLK10 to the front panel SMB connector. In non-Slot 0 operation this 
jumper will also route the VXIbus CLK10 out of the front panel SMB 
connector.

Figure C-4.  Setting the Front Panel CLK10 SMB Direction with Jumper W2

Selecting the CLK10 Source

W3—External CLK10 Source Select
When W4—CLK10 Source Select is set to select an external CLK10 
source, W3 is used to select between two external CLK10 sources.

• The default setting, shown in Figure C-5a, SMB, selects the front 
panel SMB connector as the external CLK10 source. There is no need 
to set the direction of the SMB with jumper W2 as the controller will 
set the SMB as an input for you.

a. IN (default) b. OUT

Set this jumper to OUT to route
CLK10 out of the front panel
SMB connector.

Setting this jumper to IN turns off
the SMB. Use jumpers W3 and W4
to configure the SMB as an input
when in Slot 0 operation.

1

2

3

1

2

3

W2 W2
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• Set the W3 jumper to TRIG/CLK PORT A(B), shown 
in Figure C-5b, to select the CLK10 source as the 
TRIG/CLK PORT A(B) on the VXI-8360T front panel. When 
selecting the trigger card as the CLK10 input source be sure 
to set jumper W7 to set the direction of CLK10 through the 
TRIG/CLK PORT A(B).

Figure C-5.  Selecting the External CLK10 Source with the W3 Jumper

W4—CLK10 Source Select
In Slot 0 operation the CLK10 Source Select jumper allows you to select 
the source for the VXIbus CLK10 that is routed to the backplane.

The default setting, Internal Oscillator, shown in Figure C-6a, uses the 
internal 10MHz ±100 ppm oscillator as the VXIbus CLK10 source. 

Set the W4 jumper to External Source, shown in Figure C-6b, to use the 
front panel SMB or the TRIG/CLK PORT A(B) as the CLK10 source. 
Jumper W3 External CLK10 Source Select is used in conjunction with W4 
when W4 is set to select an external oscillator as the VXIbus CLK10 
source.

Figure C-6.  Selecting the CLK10 Source with the W4 Jumper

a. Front Panel
SMB Connector

(Default)

b. Front Panel
TRIG/CLK PORT

When W3 is set to select the
TRIG/CLK PORT as the CLK10
source, use jumper W7 to set
the direction of CLK10 through
the TRIG/CLK PORT.

1

2

3

1

2

3

W3 W3

a. Internal
10 MHz

Oscillator
(Default)

b. External
10 MHz
Source

When W4 is set to select an external
CLK10 source, use jumper W3 to select
between the front panel SMB connector
or the TRIG/CLK PORT A(B).

W4 W4
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TRIG/CLK PORT A(B) Direction

W7—Trigger Card CLK10 Dir
This jumper allows you to configure the direction of CLK10 through the 
TRIG/CLK PORT A(B).

• In Slot 0 operation with jumpers W4 set for an external source and W3 
set for the front panel TRIG/CLK PORT A(B) set this jumper to In, as 
shown in Figure C-7a, to route CLK10 in from another NI VXI-8360T 
to the VXI backplane. In non-slot 0 operation the In setting has no 
effect.

• In Slot 0 and non-Slot 0 operation setting this jumper to Out, 
as shown in Figure C-7b, routes the VXIbus CLK10 out of the 
TRIG/CLK PORT A(B).

Figure C-7.  Setting the TRIG/CLK PORT A(B) Direction with Jumper W7

Optional CLK10 Settings

Inverting CLK10
If the front panel SMB connector EXT CLK is configured as an output this 
software setting provides the capability to invert the clock output. This 
setting can be found in the hardware configuration panels in MAX as 
shown in Figure C-8.

Set this jumper to OUT to route CLK10
out of the TRIG/CLK PORT.

Set this jumper to IN when the NI VXI-8360T
is in Slot 0 and W3 and W4 are configured to
select the TRIG/CLK PORT as the external
CLK10 source. Otherwise leave W7 set to IN
for other W3 and W4 combinations.

b. OUT

1

2

3

W7

a. IN
(Default)

1

2

3

W7
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Figure C-8.  Inverting the CLK10 Signal through MAX

CLK10 Termination
If the front panel SMB connector EXT CLK is configured as an input 
this software setting can enable 50 Ω parallel termination. This setting 
can be found in the hardware configuration panels in MAX, as shown in 
Figure C-8.

Trigger Input Termination
Optional software enabled 50 Ω parallel termination is available for the 
front panel trigger input. This setting can be found in the hardware 
configuration panels in MAX, as shown in Figure C-8.

Note Parallel termination is not necessary when the signal is driven by a 50 Ω source, such 
as a VXI-MXI-Express Series controller.
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D
Using The Trigger Ports On The 
VXI-8360T

The NI VXI-8360T allows you to extend the 8 TTL backplane triggers and 
CLK10 between chassis through convenient front panel connectors. Each 
trigger and the CLK are independently configurable as either inputs or 
outputs of the frame. The trigger bus is connected in a daisy chain topology 
and can support up to six (6) devices with a total of 19 m of cables.

Cautions The trigger bus uses the MXI-Express x4 cables, however these are not 
MXI-Express x4 ports. Do not connect the trigger ports to a MXI-Express x4 or 
PCI Express x4 device.

The trigger bus may be able to support more devices and/or greater cable lengths, but these 
configurations have not been validated by National Instruments and are not currently 
supported.

Connecting the Trigger Port Cables
When connecting the cables between two devices on the trigger bus, 
always ensure you connect TRIG/CLK PORT A of one device to 
TRIG/CLK PORT B of the second device, or TRIG/CLK PORT B 
of one device to TRIG/CLK PORT A of the second device, as shown 
in Figure D-1. The front panel LED will blink red if the cables are not 
connected correctly. The LED will be lit steady state green if they are 
connected properly.

Note Trigger bus cables may be removed and inserted while power is on.
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Figure D-1.  VXI-MXI-Express Series Controller Trigger Cabling

Software Configuration
Triggers are mapped into and out of your NI VXI-8360T though software 
using the following steps.

1. Open MAX.

2. Find your device under Devices and Interfaces.

3. Right click on your device and select Properties.

4. Click on the Signal Mappings Tab.

5. From each TTL Trigger select Into the Frame, Out of the Frame, 
or None.

6. Click OK and re-run the VXI Resource Manager (Resman) for the 
changes to take effect.

Note Do not map the same trigger out of the frame on more than one device on the trigger 
bus. This will cause the bus to be driven by more than one device. Protection circuitry 
prevents this from causing physical damage, however your setup will not function properly.

1 TRIG/CLK PORT A
2 TRIG/CLK PORT B
3 VXI-8360T Controller in Slot 0

4 Trigger Cable
5 VXI Mainframe

To host controller

5

1

2

4

3
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E
VMEbus Capability Codes

This appendix summarizes the VMEbus capability codes for the hardware 
and software in the VXI-MXI-Express kit.

VMEbus Capability Codes

Capability Code Description

A32, A24, A16 (master) VMEbus master A32, A24, and A16 addressing

A32, A24, A16 (slave) VMEbus slave A32, A24, and A16 addressing

D32, D16, D08(EO) (master) VMEbus master D32, D16, and D08 data sizes

D32, D16, D08(EO) (slave) VMEbus slave D32, D16, and D08 data sizes

BLT, MBLT (master) VMEbus master block and D64 transfers

BLT, MBLT (slave) VMEbus slave block and D64 transfers

RMW (master) VMEbus master read/modify/write transfers

RMW (slave) VMEbus slave read/modify/write transfers

RETRY (master) VMEbus master retry support

RETRY (slave) VMEbus slave retry support

FSD First slot detector

SCON VMEbus System Controller

PRI, RRS Prioritized or Round Robin Select arbiter

ROR, FAIR Release on Request and FAIR bus requester

IH(7–1) Interrupt handler for levels 7–1

I(7–1) Interrupt requester for levels 7–1

D32, D16, D08(O) (Interrupt Handler) VMEbus D32, D16, D08(O) interrupt handler

D32, D16, D08(O) (Interrupter) VMEbus D32, D16, D08(O) interrupter
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ROAK, RORA Release on Acknowledge or Register Access interrupter

BTO(x) VMEbus bus timer (programmable limit)

Capability Code Description
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F
Common Questions

This appendix addresses common questions you may have about using the 
NI-VISA/NI-VXI software on the VXI-MXI-Express Series controller 
platform.

What is the maximum length of the VXI-MXI-Express Series 
controller copper cable?

The maximum length for the VXI-MXI-Express Series controller copper 
cable is 7 m. National Instruments offers 1 m, 3 m, and 7 m copper cables.

I need more devices than can fit in one chassis. How can I expand my 
VXI-MXI-Express Series controller system?

Many applications can be easily extended to multiple chassis by adding 
additional VXI-MXI-Express Series controllers to the host computer 
and using the trigger and clock sharing features of the VXI-8360T to 
synchronize events between chassis. In the event that VXI or VME bus 
mastering devices must communicate to devices in other chassis directly, 
National Instruments recommends that you use a VXI-MXI-2 interface, 
which implements the VXI-6 specification for mainframe extension. This 
extends full VXI functionality across multiple mainframes, including a 
common device address space, interframe triggering, interrupts, and bus 
mastering. Place a VXI-MXI-2 in the same mainframe with the Slot 0 
VXI-MXI-Express Series controller, and another VXI-MXI-2 in Slot 0 of 
the next mainframe. You can then fill up this mainframe with additional 
devices. Refer to the MXI-2 Configuration Reference Manual available at 
ni.com for additional configuration instructions.

How can I determine the serial number of the VXI-MXI-Express 
Series controller?

This information is displayed in the title bar of the Hardware Configuration 
window in MAX.

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix F Common Questions

VXI-MXI-Express Series User Manual F-2 ni.com

What is Resman?

Resman is the utility that performs the duties of a VXI Resource Manager 
as discussed in the VXIbus specification. When you set a National 
Instruments controller to Logical Address 0, you will at some point need to 
run Resman to configure your VXI instruments. If your controller uses a 
different (nonzero) logical address and is a message-based device, you need 
to start Resman before running it on the Logical Address 0 computer.

When do I need to run Resman?

Run Resman whenever you need to configure your VXI instruments (for 
example, when you power cycle either the host computer or the chassis).

Which NI-VXI utility program must I use to configure the 
VXI-MXI-Express Series controller?

Use Measurement & Automation Explorer (MAX) to configure the 
VXI-MXI-Express Series controller. MAX is in the National 
Instruments program group folder, and a shortcut is on your desktop.

How do I handle VME devices?

Although there is no way to automatically detect VME devices in a system, 
you can add them easily through the Add Device Wizard in MAX. Through 
this procedure, you can reserve resources for each of your VME devices 
and configure MAX to show VME devices on the screen with all your other 
devices.

Which NI-VXI utility program must I use to perform startup Resource 
Manager operations?

Use the Resman program to perform startup Resource Manager operations 
in Start»Programs»National Instruments»VXI. Resman uses the 
settings configured in MAX. It initializes your VXI/VMEbus system and 
makes the information it collects accessible through MAX. You can also 
run Resource Manager operations from MAX. Through MAX, you can also 
configure Resman to run automatically at Windows startup.

What can I do to make sure that my system is up and running?

The fastest method for testing the system is to run Resman. This program 
attempts to access memory in the upper A16 address space of each 
device in the system. If Resman does not report any problems, the 
VXI-MXI-Express Series controller communication system is operational. 
To test individual devices, you can use the VIC or VISAIC program to 
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interactively issue NI-VXI functions or NI-VISA operations, respectively. 
You can use viIn() and viOut() with the NI-VISA API (or VXIin() or 
VXIinReg() and VXIout() or VXIoutReg() with the NI-VXI API) to 
test register-based devices by programming their registers. If you have 
any message-based devices, you can send and receive messages with the 
viRead() and viWrite() operations in the NI-VISA API (or WSrd() 
and WSwrt() functions in the NI-VXI API). Notice that VXIinReg() and 
VXIoutReg() are for VXI devices only, but you can use VXIin() and 
VXIout() for both VXI and VME. Finally, if you are using LabVIEW or 
LabWindows/CVI and you have instrument drivers for the devices in your 
chassis, you can use the interactive features of these programs to quickly 
test the functionality of the devices.

What do the LEDs on the front of the VXI-MXI-Express Series 
controller mean?

The VXI-MXI-Express Series controller has the following front panel 
LEDs:

• FAILED—Indicates the VXI-MXI-Express Series controller failed 
power on diagnostics.

• SYSFAIL—Indicates the VMEbus SYSFAIL line has been asserted 
on the backplane.

• ONLINE —Indicates the board is detected and ready for use.

• ACCESS—Indicates a VXI bus master is accessing the 
VXI MXI-Express Series controller.

• CB—Indicates the circuit breaker has tripped from an over current 
condition on the +5.0 VDC rail of the VXI-MXI-Express Series 
controller.

• ACT—Indicates bus activity on the MXI-Express link.

• PWRGD—Indicates the on board power supplies are in regulation.

• LINK—Indicates the MXI-Express link connecting the host computer 
to the VXI-MXI-Express Series controller has been established.

What kind of signal is CLK10 and what kind of signal do I need for an 
external CLK10?

CLK10 is a differential ECL signal on the VXIbus backplane. However, the 
oscillator for the VXI-MXI-Express Series controller and the EXT CLK 
SMB input from the front panel are TTL. Therefore, supply a TTL-level 
signal at the EXT CLK SMB and onboard circuits convert the signal to 
differential ECL.
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What is the accuracy of the CLK10 signal?

The CLK10 generated by the VXI-MXI-Express Series controller is 
±100 ppm per the VXI specification. To use a more accurate reference for 
CLK10, connect the signal to the controller through the EXT CLK SMB 
input on the front panel.
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G
Technical Support and 
Professional Services

Visit the following sections of the award-winning National Instruments 
Web site at ni.com for technical support and professional services:

• Support—Technical support resources at ni.com/support include 
the following:

– Self-Help Technical Resources—For answers and solutions, 
visit ni.com/support for software drivers and updates, a 
searchable KnowledgeBase, product manuals, step-by-step 
troubleshooting wizards, thousands of example programs, 
tutorials, application notes, instrument drivers, and so on. 
Registered users also receive access to the NI Discussion Forums 
at ni.com/forums. NI Applications Engineers make sure every 
question submitted online receives an answer.

– Standard Service Program Membership—This program 
entitles members to direct access to NI Applications Engineers 
via phone and email for one-to-one technical support as well as 
exclusive access to on demand training modules via the Services 
Resource Center. NI offers complementary membership for a full 
year after purchase, after which you may renew to continue your 
benefits. 

For information about other technical support options in your 
area, visit ni.com/services, or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using 
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the manufacturer’s declaration of conformity. This system affords 
the user protection for electromagnetic compatibility (EMC) and 
product safety. You can obtain the DoC for your product by visiting 
ni.com/certification.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

μ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

G giga 109

T tera 1012

Symbols

° Degrees.

Ω Ohms.

A

A Amperes.

address Character code that identifies a specific location (or series of locations) in 
memory. In VISA, it identifies a resource.

address modifier One of six signals in the VMEbus specification used by VMEbus masters 
to indicate the address space in which a data transfer is to take place.

address space A set of 2n memory locations differentiated from other such sets in 
VXI/VMEbus systems by six addressing lines known as address modifiers. 
n is the number of address lines required to uniquely specify a byte location 
in a given space. Valid numbers for n are 16, 24, 32, and 64. In VME/VXI, 
because there are six address modifiers, there are 64 possible address 
spaces.
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ANSI American National Standards Institute

API Application Programming Interface—the direct interface that an end user 
sees when creating an application.

arbitration A process in which a potential bus master gains control over a particular 
bus.

B

B Byte—eight related bits of data, an 8-bit binary number. Also used to 
denote the amount of memory required to store one byte of data.

backplane An assembly, typically a printed circuit board, with 96-pin connectors and 
signal paths that bus the connector pins. A C-size VXIbus system will have 
two sets of bused connectors called J1 and J2. A D-size VXIbus system will 
have three sets of bused connectors called J1, J2, and J3.

BERR* bus error signal

BIOS Basic Input/Output System. BIOS functions are the fundamental level 
of any PC or compatible computer. BIOS functions embody the basic 
operations needed for successful use of the computer’s hardware resources.

block-mode transfer An uninterrupted transfer of data elements in which the master sources only 
the first address at the beginning of the cycle. The slave is then responsible 
for incrementing the address on subsequent transfers so that the next 
element is transferred to or from the proper storage location. A VME 
data transfer may have no more than 256 elements.

bus The group of conductors that interconnect individual circuitry in a 
computer. Typically, a bus is the expansion vehicle to which I/O or other 
devices are connected. Examples of buses include the ISA bus, PCI bus, 
VXI bus, and VME bus.

bus error An error that signals failed access to an address. Bus errors occur with 
low-level accesses to memory and usually involve hardware with bus 
mapping capabilities. For example, nonexistent memory, a nonexistent 
register, or an incorrect device access can cause a bus error.

bus master A device that is capable of requesting the Data Transfer Bus (DTB) for the 
purpose of accessing a slave device.
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byte order How bytes are arranged within a word or how words are arranged within 
a longword. Motorola ordering stores the most significant byte (MSB) 
or word first, followed by the least significant byte (LSB) or word. Intel 
ordering stores the LSB or word first, followed by the MSB or word.

C

C Celsius

CLK10 A 10 MHz, ±100 ppm, individually buffered (to each module slot), 
differential ECL system clock that is sourced from Slot 0 of a VXIbus 
mainframe and distributed to Slots 1 through 12 on P2. It is distributed to 
each slot as a single-source, single-destination signal with a matched delay 
of under 8 ns.

Commander A message-based device that is also a bus master and can control one or 
more Servants.

configuration registers A set of registers through which the system can identify a module 
device type, model, manufacturer, address space, and memory 
requirements. To support automatic system and memory configuration, 
the VXI specification requires that all VXIbus devices have a set of such 
registers.

D

Data Transfer Bus DTB; one of four buses on the VMEbus backplane. The DTB is used by a 
bus master to transfer binary data between itself and a slave device.

DMA Direct Memory Access—a method by which data is transferred between 
devices and internal memory without intervention of the central processing 
unit. DMA is the fastest method of transferring data to/from computer 
memory.

DRAM Dynamic RAM (Random Access Memory)—storage that the computer 
must refresh at frequent intervals.

dynamic 
configuration

A method of automatically assigning logical addresses to VXIbus devices 
at system startup or other configuration times.
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dynamically 
configured device

A device that has its logical address assigned by the Resource Manager. 
AVXI device initially responds at Logical Address 255 when its MODID 
line is asserted. The Resource Manager subsequently assigns it a new 
logical address, to which the device responds until powered down.

E

ECL Emitter-Coupled Logic

EEPROM Electronically Erasable Programmable Read Only Memory—ROM that 
can be erased with an electrical signal and reprogrammed.

embedded controller An intelligent CPU (controller) interface plugged directly into the VXI 
backplane, giving it direct access to the VXIbus. It must have all of its 
required VXI interface capabilities built in.

EMC electromagnetic compliance

EMI electromagnetic interference

external trigger A voltage pulse from an external source that triggers an event.

F

fair requester A VXIbus device that will not arbitrate for the VXIbus after releasing 
it until it detects the bus request signal inactive. This ensures that all 
requesting devices will be granted use of the bus.

firmware Software embedded in the VXI-MXI-Express Series controller, contained 
on EEPROM and flash memory that can be updated with a special utility 
(part of MAX). In combination with the hardware, the firmware enables the 
VXI-MXI-Express Series controller to act as a translator between USB and 
VXI protocols.

G

g (1) grams
(2) a measure of acceleration equal to 9.8 m/s2

GPIB General Purpose Interface Bus (IEEE 488)
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gRMS A measure of random vibration. The root mean square of acceleration 
levels in a random vibration test profile.

H

hex Hexadecimal—the numbering system with base 16, using the digits 0 to 9 
and letters A to F.

Hz hertz; cycles per second

I

I/O Input/output—the techniques, media, and devices used to achieve 
communication between machines and users.

IEC International Electrotechnical Commission. The IEC publishes 
internationally recognized standards. IEC 60068 contains information 
on environmental testing procedures and severities.

IEEE Institute of Electrical and Electronics Engineers

in. inches

instrument driver A set of routines designed to control a specific instrument or family of 
instruments, and any necessary related files for LabWindows/CVI or 
LabVIEW.

interrupt A means for a device to request service from another device; a computer 
signal indicating that the CPU should suspend its current task to service a 
designated activity.

interrupt handler A VMEbus functional module that detects interrupt requests generated by 
interrupters and responds to those requests by requesting status and identify 
information.

interrupt level The relative priority at which a device can interrupt.

IRQ* interrupt signal
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K

K kilo—the prefix for 1,024, or 210, used with B (byte) in quantifying data or 
computer memory.

k kilo—the standard metric prefix for 1,000, or 103, used with units of 
measure such as volts, hertz, and meters.

L

logical address An 8-bit number that uniquely identifies each VXIbus device in a system. 
It defines the A16 register address of a device, and indicates Commander 
and Servant relationships.

M

m meters

M mega—(1) the standard metric prefix for 1 million or 106, when used with 
units of measure such as volts and hertz; (2) the prefix for 1,048,576, or 220, 
when used with B (byte) to quantify data or computer memory.

master A functional part of a VME/VXIbus device that initiates data transfers on 
the backplane. A transfer can be either a read or a write.

message-based
device

An intelligent device that implements the defined VXIbus registers and 
communication protocols. These devices are able to use Word Serial 
Protocol to communicate with one another through communication 
registers.

MODID Module ID lines—used in VXI to geographically locate boards and to 
dynamically configure boards.

MTBF Mean Time Between Failure

MXI-3 A PCI Master/Slave system implementing the PCI-to-PCI Bridge register 
set. It couples two physically separate PCI buses with either a copper or 
fiber optic data link capable of 1.5 Gbits/s serial data rates.

MXI-Express An extension of MXI based upon PCI Express. MXI-Express provides 
bandwidth of up to 110 MB/s.
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N

NI-488.2 or
NI-488.2M

The National Instruments industry-standard software for controlling 
GPIB instruments.

NI-DAQ The National Instruments industry-standard software for data acquisition 
instruments.

NI-VISA The National Instruments implementation of the VISA standard; an 
interface-independent software that provides a unified programming 
interface for VXI, GPIB, and serial instruments.

NI-VXI The National Instruments bus interface software for VME/VXIbus 
systems.

Non-Slot 0 device A device configured for installation in any slot in a VXIbus mainframe 
other than Slot 0. Installing such a device into Slot 0 can damage the device, 
the VXIbus backplane, or both.

P

PCI Peripheral Component Interconnect. The PCI bus is a high-performance 
32-bit or 64-bit bus with multiplexed address and data lines.

PCI Express A serialized, highly scalable I/O interconnect standard that leverages 
existing PCI technology such as the software model and the load-store 
architecture.

R

register-based device A Servant-only device that supports VXIbus configuration registers. 
Register-based devices are typically controlled by message-based devices 
via device-dependent register reads and writes.

Resman The name of the National Instruments Resource Manager in NI-VXI bus 
interface software. See also Resource Manager.

Resource Manager A message-based Commander located at Logical Address 0, which 
provides configuration management services such as address map 
configuration, Commander and Servant mappings, and self-test and 
diagnostic management.
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retry An acknowledge by a destination that signifies that the cycle did not 
complete and should be repeated.

RMS Root mean squared. See also gRMS.

S

s seconds

slave A functional part of a VME/VXIbus device that detects data transfer cycles 
initiated by a VMEbus master and responds to the transfers when the 
address specifies one of the device’s registers.

Slot 0 device A device configured for installation in Slot 0 of a VXIbus mainframe. This 
device is unique in the VXIbus system in that it performs the VXI/VMEbus 
System Controller functions, including clock sourcing and arbitration for 
data transfers across the backplane. Installing such a device into any other 
slot can damage the device, the VXIbus backplane, or both.

SMB Sub Miniature Type B connector that features a snap coupling for fast 
connection.

statically configured 
device

A device whose logical address cannot be set through software; that is, it is 
not dynamically configurable.

SYSFAIL A VMEbus signal that is used by a device to indicate an internal failure. 
A failed device asserts this line. In VXI, a device that fails also clears its 
PASSed bit in its Status register.

T

trigger Either TTL or ECL lines used for intermodule communication.

TTL Transistor-Transistor Logic

U

USB Universal Serial Bus—a serial bus for connecting computers to keyboards, 
printers, and other peripheral devices.
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V

V volts 

VIC VXI Interactive Control program, a part of the NI-VXI bus interface 
software. Used to program VXI devices and develop and debug VXI 
application programs.

VISA Virtual Instrument Software Architecture. This is the general name given 
to VISA and its associated architecture.

VISAIC VISA Interactive Control program, a part of the NI-VISA software. 
Used to program devices and develop and debug application programs.

VITA VMEbus International Trade Association

VME Versa Module Eurocard or IEEE 1014

VMEbus System 
Controller

A device configured for installation in Slot 0 or a VXIbus mainframe or the 
first slot in a VMEbus chassis. This device is unique in the VMEbus system 
in that it performs the VMEbus System Controller functions, including 
clock sourcing and arbitration for data transfers across the backplane. 
Installing such a device into any other slot can damage the device, the 
VMEbus/VXIbus backplane, or both.

VXIbus VMEbus Extensions for Instrumentation

W

W watts

Word Serial Protocol The simplest required communication protocol supported by 
message-based devices in a VXIbus system. It utilizes the A16 
communication registers to transfer data using a simple polling handshake 
method.

write posting A mechanism that signifies that a device will immediately give a successful 
acknowledge to a write transfer and place the transfer in a local buffer. The 
device can then independently complete the write cycle to the destination.
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Index

A
advanced configuration options, 1-4
advanced hardware configuration settings, C-1
application development, 3-1

configuration, 3-2
debugging, 3-9
device interaction, 3-3
NI-VXI API notes, 3-8
optimizing large VXIbus transfers, 3-7
programming for VXI, 3-6

C
cables, connecting, 2-6
cabling triggers between two controllers 

(figure), D-2
CE compliance specifications, A-4
cleaning specifications, A-5
CLK10 routing, VXI bus, C-4

front panel SMB direction, C-5
W2 jumper, C-5

optional settings, C-7
inverting CLK10, C-7
inverting CLK10 (figure), C-8
termination, C-8

selecting external source
W3 jumper, C-5

selecting source, C-5
W4 jumper, C-6
W4 jumper (figure), C-6

TRIG/CLK port A/B direction, C-7
W7 jumper, C-7

CLK10 signal
accuracy, F-4
definition, F-3
inverting (figure), C-8

common questions, F-1
compatibility layer options, 3-8
compiler symbols, 3-8
completing software installation, 2-2
configuration, 2-1, 3-2

advanced hardware settings, C-1
advanced options, C-1
MITE EEPROM, C-2
options, 1-4
slot 0 detection, C-1
slot 0 detection (figure), C-2
VXI-8360T trigger ports, D-1
VXI-MXI-Express shipping configuration 

settings (figure), B-2
connecting cables, 2-6
conventions used in the manual, vii

D
debugging, 3-9
Declaration of Conformity (NI resources), G-1
default settings

configuration, B-1
hardware, B-1
software, B-3

developing applications, 3-1
device interaction, 3-3
device tab default settings (table), B-3
diagnostic tools (NI resources), G-1
documentation

conventions used in manual, vii
NI resources, G-1
related documentation, viii

drivers (NI resources), G-1
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E
EEPROM, C-3

configuration, C-3
fixing an invalid configuration, C-3

electromagnetic compatibility, A-4
environmental management 

specifications, A-5
environmental specifications, A-2
examples (NI resources), G-1
EXT CLK specifications, A-1

F
front panel features, 1-3

G
getting started, 1-2

H
hardware

advanced configuration settings, C-1
configuration, 2-3, 3-2
default settings, B-1
description, 1-2
determining serial number, F-1
installation, 2-3
VXI-8360T trigger port settings, D-1

help, technical support, G-1
host system with VXI-MXI-Express series 

controller (figure), 2-7

I
installation, 2-1

hardware, 2-3
software, 2-1

instrument drivers (NI resources), G-1
introduction, 1-1
inverting the CLK10 signal (figure), C-8

K
KnowledgeBase, G-1

L
LabVIEW, 1-5
LabWindows/CVI, 1-5
LEDs, F-3

M
Measurement & Automation Explorer, 1-4

device tab default settings (table), B-3
PCI tab default settings (table), B-4
shared memory tab default settings 

(table), B-3
SMB tab default settings (table), B-4
VXI bus tab default settings (table), B-4

Measurement Studio, 1-5
MITE EEPROM

See also EEPROM
configuration, C-2
power on self configuration, C-3
user/factory configuration, C-2

N
National Instruments

application software, 1-4
support and services, G-1

NI ExpressCard-8360 installation, 2-6
NI PCIe-8361/NI PCIe-8362

installation, 2-5
figure, 2-6

NI Spy, 3-9
figure, 3-10

NI support and services, G-1
NI-VISA, 1-4, 3-1

examples (table), 3-7
installation, 2-1
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NI-VXI, 1-4, 3-1
compatibility layer, 3-1
examples (table), 3-7
installation, 2-1
utility programs

using to configure 
VXI-MXI-Express series 
controller, F-2

using to perform startup Resource 
Manager operations, F-2

NI-VXI API, 3-1
compatibility layer options, 3-8
compiler symbols, 3-8
notes, 3-8

O
operating environment specifications, A-3
optimizing large VXIbus transfers, 3-7

P
PCI tab default settings (table), B-4
physical specifications, A-2
POSC (power-on self-configuration), C-3
power requirement specifications, A-1
power-on self-configuration (POSC), C-3
programming examples (NI resources), G-1
programming for VXI, 3-6

R
Register I/O tab, successful viIn access in 

(figure), 3-5
related documentation, viii
Resman, 1-4, F-2

running (figure), 3-3
using to ensure system is up and 

running, F-2
when to run, F-2

Resource Manager, 1-4

S
safety specifications, A-4
selecting controller in VISAIC (figure), 3-4
selecting the CLK10 source (figure), C-6
serial number, determining, F-1
shared memory tab default settings 

(table), B-3
shock and vibration specifications, A-3
slot 0 detection

configuration, C-1
J2 jumper (figure), C-2

SMB tab default settings (table), B-4
software

configuration, 2-8
installation, 2-1

completing, 2-2
NI resources, G-1
verification, 2-8

specifications
CE compliance, A-4
cleaning, A-5
electromagnetic compatibility, A-4
environmental, A-2

operating environment, A-3
shock and vibration, A-3
storage environment, A-3

environmental management, A-5
Waste Electrical and Electronic 

Equipment (WEEE), A-5
EXT CLK, A-1
physical, A-2
power requirement, A-1
safety, A-4
TRIG IN, A-1
TRIG OUT, A-2

storage environment specifications, A-3
support, technical, G-1
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T
technical support, G-1
termination resistance for CLK10, C-8
training and certification (NI resources), G-1
TRIG IN specifications, A-1
TRIG OUT specifications, A-2
trigger ports

cabling, D-1
cabling (figure), D-2
software configuration, D-2

troubleshooting (NI resources), G-1

U
user-configurable settings, C-1
using the VXI-8360T trigger ports, D-1

V
VISAIC, 3-10

figure, 3-10
selecting controller in (figure), 3-4
successful viIn access in Register I/O tab 

(figure), 3-5
VME devices, handling, F-2
VMEbus capability codes

list (table), E-1
VXI bus tab default settings (table), B-4
VXI, programming for, 3-6
VXI-8360T trigger ports, D-1
VXIbus transfers, optimizing, 3-7
VXIbus, CLK10 routing, C-4

front panel SMB direction, C-5
W2 jumper, C-5

optional settings, C-7
inverting CLK10, C-7

figure, C-8
termination, C-8

selecting external source
W3 jumper, C-5

selecting source, C-5
W4 jumper, C-6
W4 jumper (figure), C-6

TRIG/CLK port A/B direction, C-7
W7 jumper, C-7

VXI-MXI-Express series controller
advanced configuration options, 1-4
application development, 3-1
common questions, F-1
configuration, 2-1, 3-2
copper cable lengths, F-1
default configuration settings, B-1
default software settings, B-3
determining serial number, F-1
determining which NI-VXI utility to use 

with, F-2
ensuring that system is up and 

running, F-2
expanding system, F-1
front panel features, 1-3
front panel LEDs, F-3
getting started, 1-2
hardware

configuration, 2-3
default settings (table), B-3
description, 1-2
installation, 2-3

installation, 2-1, 2-3
introduction, 1-1
shipping configuration settings 

(figure), B-2
software

configuration and verification, 2-8
installation, 2-1

specifications, A-1

W
Waste Electrical and Electronic Equipment 

(WEEE) specifications, A-5
Web resources, G-1
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